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Databases

Appendix

Search Strategy

Scopus

Search
Query 1
AND 2

TITLE-ABS-KEY(( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-
specific" OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND
("health*" OR "healthcare*" OR "healthcare" OR "health services" OR "well being" OR
"wellbeing*" OR "well-being" OR "wellness*" OR "mental health" OR "medic*" OR
"iliness" OR "disease*" OR "condition" OR "healthy behaviours" OR "community
wellbeing" OR "community well-being" OR "community well being" OR "community
wellness")) AND PUBYEAR >1979 AND (LIMIT-TO (LANGUAGE, "English"))

Search
Query 1
AND 3

TITLE-ABS-KEY(( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-
specific" OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND (
"Income" OR "social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )) AND
PUBYEAR >1979 AND (LIMIT-TO (LANGUAGE, "English"))

Medline

Search
Query 1
AND 2

(( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")). mp. [mp=title, book title,
abstract, original title, name of substance word, subject heading word, floating sub-
heading word, keyword heading, organism supplementary concept word, protocol
supplementary concept, rare disease supplementary concept word, unique identifier,
synonyms]

limit to (english language and yr ="1980-2023")

Search
Query 1
AND 3

(("metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )). mp.
[mp=title, book title, abstract, original title, name of substance word, subject heading
word, floating sub-heading word, keyword heading, organism supplementary concept
word, protocol supplementary concept, rare disease supplementary concept word,
unique identifier, synonyms]

limit to (english language and yr ="1980-2023")
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Embase

Search
Query 1
AND 2

(( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")). mp. [mp=title, abstract,
heading word, drug trade name, original title, drug manufacturer, device trade name,
keyword heading word, floating subheading word, candidate term word]

limit to (english language and yr ="1980-2023")

Search
Query 1
AND 3

(( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )). mp.
[mp=title, abstract, heading word, drug trade name, original title, drug manufacturer,
device trade name, keyword heading word, floating subheading word, candidate term
word]

limit to (english language and yr ="1980-2023")

Web of Science

Search
Query 1
AND 2

( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")

limit to English; no publication filter (earliest was 1992)

Search
Query 1
AND 3

( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )

limit to English; no publication filter (earliest was 1991)

CINAHL

Search
Query 1
AND 2

AB ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND AB ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
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OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")

Abstract Available, Published Date: 1980, English language
Boolean/ Phrase

Search
Query 1
AND 3

AB ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND AB ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )

Abstract Available, Published Date: 1980, English language
Boolean/ Phrase

APA Psych Info

Search
Query 1
AND 2

(("metis" or "Métis*" or "Métis Nation" or "Métis-specific" or "metis-specific" or "mixed
blood" or "half-breed" or "half breed" or "voyageur") and ("health*" or "healthcare*" or
"healthcare" or "health services" or "well being" or "wellbeing*" or "well-being" or
"wellness*" or "mental health" or "medic*" or "illness" or "disease*" or "condition" or
"healthy behaviours" or "community wellbeing" or "community well-being" or
"community well being" or "community wellness")).mp. [mp=title, abstract, heading
word, table of contents, key concepts, original title, tests & measures, mesh word]

limit to (english language and yr ="1980-2023")

Search
Query 1
AND 3

(("metis" or "Métis*" or "Métis Nation" or "Métis-specific" or "metis-specific" or "mixed
blood" or "half-breed" or "half breed" or "voyageur") and ( "Income" OR "social status"
OR "poverty" OR "housing" OR "racism" OR "colonialism" OR "employment" OR "working
conditions" OR "education" OR "literacy" OR "childhood experiences" OR "physical
environment" OR "social supports" OR "community supports" OR "coping skills" OR
"gender" OR "culture" OR "land" OR "animals" OR "water*" )).mp. [mp=title, abstract,
heading word, table of contents, key concepts, original title, tests & measures, mesh
word]

limit to (english language and yr ="1980-2023")

Anthropology Plus

Search
Query 1
AND 2

TX ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND TX ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")

limit to (english language and yr ="1980-2023")
Boolean/ Phrase
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Search
Query 1
AND 3

TX ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND TX ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )

limit to (english language and yr ="1980-2023")
Boolean/ Phrase

Bibliography of Indigenous Peoples

Search
Query 1
AND 2

AB ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND AB ("health*" OR
"healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*" OR
"well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR "disease*"
OR "condition" OR "healthy behaviours" OR "community wellbeing" OR "community well-
being" OR "community well being" OR "community wellness")

limit to (english language and yr ="1980-2023")
Boolean/ Phrase

Search
Query 1
AND 3

AB ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific" OR
"mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND AB ( "Income" OR
"social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR
"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" )

limit to (english language and yr ="1980-2023")
Boolean/ Phrase

Canadian Business and Current Affairs

Search
Query 1
AND 2

summary ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-
specific" OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND
summary ("health*" OR "healthcare*" OR "healthcare" OR "health services" OR "well
being" OR "wellbeing*" OR "well-being" OR "wellness*" OR "mental health" OR "medic*"
OR "illness" OR "disease*" OR "condition" OR "healthy behaviours" OR "community
wellbeing" OR "community well-being" OR "community well being" OR "community
wellness")

limit to (english language and yr ="1980-2023")

Search
Query 1
AND 3

summary ( "metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-
specific" OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur") AND
summary ( "Income" OR "social status" OR "poverty" OR "housing" OR "racism" OR
"colonialism" OR "employment" OR "working conditions" OR "education" OR "literacy"
OR "childhood experiences" OR "physical environment" OR "social supports" OR
"community supports" OR "coping skills" OR "gender" OR "culture" OR "land" OR
"animals" OR "water*" )
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limit to (english language and yr ="1980-2023")

Informit Indigenous Collection

Search [Abstract:"metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific"
Query 1 OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur" OR Abstract:"health*"
AND 2 OR "healthcare*" OR "healthcare" OR "health services" OR "well being" OR "wellbeing*"

OR "well-being" OR "wellness*" OR "mental health" OR "medic*" OR "illness" OR
"disease*" OR "condition" OR "healthy behaviours" OR "community wellbeing" OR
"community well-being" OR "community well being" OR "community wellness" OR
Abstract: 'métis nation' OR Abstract: 'métis-specific' OR Abstract: 'metis-specific' OR
Abstract: 'mixed blood' OR Abstract: 'half-breed' OR Abstract: 'half breed' OR Abstract:
'voyageur'] AND [Abstract: 'health*' OR Abstract: 'healthcare*' OR Abstract: 'healthcare'
OR Abstract: 'health services' OR Abstract: 'well being' OR Abstract: 'wellbeing*' OR
Abstract: 'well-being' OR Abstract: 'wellness*' OR Abstract: 'mental health' OR Abstract:
'medic*' OR Abstract: 'illness' OR Abstract: 'disease*' OR Abstract: 'condition' OR
Abstract: 'healthy behaviours' OR Abstract: ‘community wellbeing' OR Abstract:
‘community well-being' OR Abstract: 'community well being' OR Abstract: 'community
wellness'] AND Publication Date: (01/01/1980 TO 12/31/2023)

limit to (english language and yr ="1980-2023")

Search [Abstract:"metis" OR "Métis*" OR "Métis Nation" OR "Métis-specific" OR "metis-specific"
Query 1 OR "mixed blood" OR "half-breed" OR "half breed" OR "voyageur" OR Abstract:"Income"
AND 3 OR "social status" OR "poverty" OR "housing" OR "racism" OR "colonialism" OR

"employment" OR "working conditions" OR "education" OR "literacy" OR "childhood
experiences" OR "physical environment" OR "social supports" OR "community supports"
OR "coping skills" OR "gender" OR "culture" OR "land" OR "animals" OR "water*" OR
Abstract: 'métis nation' OR Abstract: 'métis-specific' OR Abstract: 'metis-specific' OR
Abstract: 'mixed blood' OR Abstract: 'half-breed' OR Abstract: 'half breed' OR Abstract:
‘'voyageur'] AND [Abstract: 'income' OR Abstract: 'social status' OR Abstract: '‘poverty' OR
Abstract: 'housing' OR Abstract: 'racism' OR Abstract: 'colonialism' OR Abstract:
'employment' OR Abstract: 'working conditions' OR Abstract: 'education' OR Abstract:
'literacy' OR Abstract: 'childhood experiences' OR Abstract: 'physical environment' OR
Abstract: 'social supports' OR Abstract: ‘community supports' OR Abstract: 'coping skills'
OR Abstract: 'gender' OR Abstract: 'culture' OR Abstract: 'land' OR Abstract: 'animals' OR
Abstract: 'water*'] AND Publication Date: (01/01/1980 TO 12/31/2023)

limit to (english language and yr ="1980-2023")

PubMed

Search ("metis"[Title/Abstract] OR "Métis*"[Title/Abstract] OR "Métis Nation"[Title/Abstract] OR
Query 1 "Métis-specific"[Title/Abstract] OR "metis-specific"[Title/Abstract] OR "mixed

AND 2 blood"[Title/Abstract] OR "half-breed"[Title/Abstract] OR "half breed"[Title/Abstract] OR
"voyageur"[Title/Abstract]) AND ("health*"[Title/Abstract] OR
"healthcare*"[Title/Abstract] OR "healthcare"[Title/Abstract] OR "health
services"[Title/Abstract] OR "well being"[Title/Abstract] OR "wellbeing*"[Title/Abstract]
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OR "well-being"[Title/Abstract] OR "wellness*"[Title/Abstract] OR "mental
health"[Title/Abstract] OR "medic*"[Title/Abstract] OR "illness"[Title/Abstract] OR
"disease*"[Title/Abstract] OR "condition"[Title/Abstract] OR "healthy
behaviours"[Title/Abstract] OR "community wellbeing"[Title/Abstract] OR "community
well-being"[Title/Abstract] OR "community well being"[Title/Abstract] OR "community
wellness"[Title/Abstract])

Abstract, English, from 1980-2023

Search
Query 1
AND 3

("metis"[Title/Abstract] OR "Métis*"[Title/Abstract] OR "Métis Nation"[Title/Abstract] OR
"Métis-specific"[Title/Abstract] OR "metis-specific"[Title/Abstract] OR "mixed
blood"[Title/Abstract] OR "half-breed"[Title/Abstract] OR "half breed"[Title/Abstract] OR
"voyageur"[Title/Abstract]) AND ("Income"[Title/Abstract] OR "social
status"[Title/Abstract] OR "poverty"[Title/Abstract] OR "housing"[Title/Abstract] OR
"racism"[Title/Abstract] OR "colonialism"[Title/Abstract] OR
"employment"[Title/Abstract] OR "working conditions"[Title/Abstract] OR
"education"[Title/Abstract] OR "literacy"[Title/Abstract] OR "childhood
experiences"[Title/Abstract] OR "physical environment"[Title/Abstract] OR "social
supports"[Title/Abstract] OR "community supports"[Title/Abstract] OR "coping
skills"[Title/Abstract] OR "gender"[Title/Abstract] OR "culture"[Title/Abstract] OR
"land"[Title/Abstract] OR "animals"[Title/Abstract] OR "water*"[Title/Abstract])

Abstract, English, from 1980-2023

ProQuest

Search
Query 1
AND 2

(("metis" or "Métis*" or "Métis Nation" or "Métis-specific" or "metis-specific" or "mixed
blood" or "half-breed" or "half breed" or "voyageur") and ("health*" or "healthcare*" or
"healthcare" or "health services" or "well being" or "wellbeing*" or "well-being" or
"wellness*" or "mental health" or "medic*" or "illness" or "disease*" or "condition" or
"healthy behaviours" or "community wellbeing" or "community well-being" or
"community well being" or "community wellness")).mp. [mp=title, abstract, heading
word, table of contents, key concepts, original title, tests & measures, mesh word]

limit to (english language and yr ="1980-2023")

Search
Query 1
AND 3

(("metis" or "Métis*" or "Métis Nation" or "Métis-specific" or "metis-specific" or "mixed
blood" or "half-breed" or "half breed" or "voyageur") and ( "Income" OR "social status"
OR "poverty" OR "housing" OR "racism" OR "colonialism" OR "employment" OR "working
conditions" OR "education" OR "literacy" OR "childhood experiences" OR "physical
environment" OR "social supports" OR "community supports" OR "coping skills" OR
"gender" OR "culture" OR "land" OR "animals" OR "water*" )).mp. [mp=title, abstract,
heading word, table of contents, key concepts, original title, tests & measures, mesh
word]

limit to (english language and yr ="1980-2023")

Indigenous Studies Portal
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Métis AND Health

Collaborative Indigenous Research Digital Garden

Métis

Hand-searching

Meétis Nation of Alberta

Resources > Publication (filter: health-related reports

Métis Nation BC

MNBC Work and Programs
> Health
> Reports
> Downloadable Resources
> *all reports and research from these pages were
downloaded*

Manitoba Métis

Departments/ Affiliates

Federation > Health and Wellness
> Publications
> *all reports and research from this page were
downloaded*
Métis Nation - Menu> Health
Saskatchewan

Métis Nation of Ontario

Programs and Services
> Healing and Wellness
> Health Research Initiative and Projects
> Current Projects
> Chronic Disease Surveillance Program
> Press Releases
> Initiative Reports
> General Reports
> Cardiovascular Disease Reports
> Diabetes Reports
> Cancer Reports
> Respiratory Disease Reports
> Other Medical Reports
> Past Projects
>0ur Health Counts Project
>Youth Identity Project
> Indigenous Knowledge Network Initiative
>Healthy Messaging Project

Métis Settlement Search: “health”
Alberta

Northwest Territory Search: “health”
Meétis Nation

Les Femmes Michif
Optemisiwak

Menu > Resources > Advanced Search
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Advanced Search Filters > Types of Resources: “Report”

Statistics Canada Subjects > Indigenous Health > Health and Well-being > Métis

Google Chrome General Grey Literature Search Strategy

Operating System: Windows

Search Engine: Google Chrome
Search: “metis health and wellness”
Search Total Results: 3,650,000
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